
 
 

 
 

Flash Drives and File Management (Windows) 
 

 
Overview: This class focuses on saving, moving, and retrieving any file on a Windows-based 
computer. We will learn how to add new folders to the computer, and rename both folders and 
individual files, with a focus on saving, renaming, and deleting documents (resumes, for example). 

 
 

Requirements: Basic mouse skills – ability to move the mouse indicator around on the computer 
screen, and easily click and double click on items on the screen. A personally-owned flash drive. 
 
 
 
Objectives 

 The student will: 
o Understand computer memory measurements and relate this information to flash 

drives 
o Understand the basics of saving, storing, and retrieving files 

 Define File Management 
 Use drives and follow pathways 
 Rename Sample Pictures and move to New Folders 

o Create a simple Word Document 
 Open Microsoft Word 
 Save the document to the USB drive (flash drive) 
 Safely remove the hardware 
 Retrieve the existing file on the USB drive 

o Create a New Folder on the USB drive 
 Rename the folder 
 Move the Word Document into the New Folder 

o Practice 
Optional: 

o Copy files from the hard drive to the flash drive 
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Computer Memory: Built-in Memory 

 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Onedrive – The Cloud 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Flash drives (a.k.a. USB, thumb, removable disk, jump drive, or 
memory stick) plug into any available USB (Universal Serial Bus) port 
on the computer. They range in size from 64 to 512Gb (64Gb costs 
$10 or less. 512Gb costs about $50 or more). Most computers come 
equipped with 6 to 8 built-in USB ports. 
 

USB plug and port 

 
Flash Drive 

Hard Disk (C: drive, Hard Drive or Local Disk) – located in the 
computer. It is made of platters (a hard drive may have from 1 to 6 
platters inside its sealed compartment) 
 
 

 
 

Memory: Portable Memory 

 

This is a picture of the hard drive that is 
located inside the computer. You should 
never open the sealed case of the hard drive 
(you will ruin the data on the platters) 
 

Flash drives are the most current way to save personal computer files. 
One flash drive is usually sufficient to save everything you need 
(pictures, text files, etc). You should own a flash drive if possible. 

 
 

USB symbol: all universal serial bus ports and plugs are identified with this symbol 

There are also SSD (Solid 
State Drives) for sale, but 
they are about 1.5 times 
more expensive than 
traditional drives. They use 
integrated circuitry to store 
data, and have much faster 
start-up and storage time 
(there’s no moving parts, 
only electricity moving 
through circuits). Wikimedia, 
Solid-State Drive, 2019) 

A new and important addition to Office and 
Windows is the Onedrive. It is essentially an 
online backup storage place that gives you 5GB 
of space for free (note that you must have 
Internet access to get your items from 
Onedrive).  
 

It is important to understand what the Onedrive 
is, as the “new office suite allows the option of 
saving documents directly to OneDrive, 
enabling users to access their Office files 
across a variety of devices.  
 

Users will also have the option of saving their 
documents locally or offline and then have them 
sync with OneDrive upon going online again” 
(Webopedia, 2013).   
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Memory Space – What does it mean to you? 

 

 

 

 

 

 

 
 
 
 
 

File Management 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Name Abbreviation Size 

Bit b 1 bit (on or off, 1 or 0, electricity or no electricity – it’s the lowest unit of 
measure – everything else is based on this) 

Byte B or b 8 bits – one typed letter (H) 

Kilobyte Kb 1000 bytes – about 1/2 page of text. 2KB is about 1page 

Megabyte Mb 1000 kilobytes – about 500 pages of text. 4Mb is about one digital 
photo or pop song 

Gigabyte Gb 1000 megabytes – 1 Gb is about 250 photos, or about 2,000 ebooks. 
5Gb is about one DVD (Hollywood movie with extra features) A Blu-ray 
is about 27Gb. 

Terabyte Tb 1000 gigabytes – about 225,000 digital photos or about 450 DVD 
movies, 2 million ebooks 

Petabyte Pb 1000 terabytes – about 450,000 DVD movies (YIKES!) or 2 BILLION 
ebooks 

Above table based on the HowStuffWorks Web site (2009). DVD and Blu-ray info: Watson, 2010. 

 
 
 

So, computers store a tremendous amount of things in a very small area. How many things? “Amazon 
estimates the average size of a Kindle book to be around 2KB per page, including the cover image and 
any internal images (Kyrnin, 2013). 2KB per page translates into about 500KB for a 250-page book. 
500KB is actually quite small. 1GB would hold about 2,000 ebooks. The average Kindle has about 5GB 
of storage space. If all you had were books on the Kindle, it could hold about 10,000 ebooks. 
 

Why on Earth am I getting into all this math and conversion? Because your average computer may have 
as much as a 3 terabyte hard drive. Just so we understand, a 3TB hard drive could hold 6,000,000 (6 
million) ebooks. That hard drive fits in the palm of your hand. 
 

For a bigger idea, the Library of Congress, founded by the donation of Thomas Jefferson’s personal 
library and one of the largest libraries in the world today, has an estimated 37 million books (Library of 
Congress, 2017). That’s on 838 miles of bookshelves (Library of Congress, 2017). 
 

You would need about 18 terabytes to contain this entire collection. Amazon.com offers a 6TB hard drive 
for $180. So, for about $540 (3 drives) you could have enough storage space for the entire book 
collection of the Library of Congress – and then some. Physically, these 3 drives would weigh less 

than 8 pounds and fit easily into a plastic grocery bag. 

How do you find anything in this mess?? 
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Follow Pathways to Find Files 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

File management deals with storing and retrieving any file you may have on the 
computer. It is important to save your files and organize them in a way you understand 
so you may find them again! 

Each pathway starts with a drive letter. Each drive on the 
computer is labeled with capital letters and a colon. For 
example: 
 C: (the hard drive/hard disk located inside the tower) 
 D: (usually a disk drive like a DVD or CD-RW) (It might 

be reserved for a System Recovery – a backup of files and drivers on 
your computer) 

 E: (usually a removable drive – a flash drive) 
 
Within each of these drives are folders that you can use to 
organize your files. 
 

Aside: The colon (:) tells the 
computer to look at the 
previous letter as the drive 
which is beginning of any 
pathway. 
 

 

It may help you to understand file 
management on the computer if we think of 
it in “real life:” 
 
If you picture a library building (this is 
your hard drive) you quickly realize you 
need to find the right shelving unit. 
(called the Parent Folder) 
 
Next, you need to find the right shelf 
(called the Subfolder) and open it. 
  
Once you have the right shelf you need 
the right book (called the Subfolder) and 
open that. 
 
Of course once you have the right folder 
you need to find the right page in the 
book (called a file) and finally, open it. 
This is the essence of file management! 
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Inside File Explorer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

You can control and create new pathways in the Windows Operating System by 
using File Explorer. “File Explorer” is an information tool used by Windows-based 
operating systems that allows you to view data information related to the files on your 
computer. 

 
Open it by clicking the icon from the Taskbar. 
 

Devices and Drives: These drives are also inside the computer but they allow you to save files to them 
and then you may take out the actual memory and carry it with you. Computers will read and write (play 
back/save to) removable devices. These computers have a DVD RW drive (E:) on them. This drive 
serves to both play back (“read”) DVDs and also save to (“write”) to them. To write to a DVD, you need 
to purchase a writeable DVD (regular DVDs are non-writeable). 
The most common device you will use for removable storage is the flash drive (labeled Removable 
Disk (F:) here). It plugs into any USB port (Universal Serial Bus) and it’s very easy to write and rewrite 
data on it (save/delete/save again). Once you have files on a flash drive, you may use the public 
workstations at any library to attach them to an email and send them off to potential employers.  
 

 

This is our current location 
(This PC is the C: drive) 
This Search bar is very useful 

NAVIGATION 
PANE:  
 
This is our 
focus area. 

For your convenience you are also told what the drives actually are: 
Hard Disk Drives: FOLDERS are on the hard drive (Desktop, Documents, Downloads, Music, 
Pictures, Videos) 
ANYTHING YOU DOWNLOAD FROM THE INTERNET goes into the Downloads folder (pictures, 
videos, games, etc.)  
 
 

Notice the 
Back and 
Forward 
buttons next 
to the 
pathway 
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Follow a Pathway to find a Picture 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Once we are in the correct drive, all we deal with are folders.  
There are Parent Folders and Subfolders. Parent Folders can be any folder 
that contains another folder. It may help to think of Parent Folders as the drawer 
of a filing cabinet. Subfolders would be represented by the actual manila colored 
folders inside the drawer. 

 

 

Windows makes it very easy to get into the Pictures folder. Just 
click once on the word on the left side of your Computer 
window. 

 

Now we see the actual files in the 
Pictures folder. You may double 
click on any of them to see a larger 
version. 

In Windows, the main place you will use for file management is the “File Explorer” listing on the left 
side of the screen. The default location to Save In: is Documents for text files (like using Word); and 
the default location for picture files is Pictures. 

 

Once in File Explorer, you 
may want to change the 
View to make files easier to 
see. Click on the View Tab 
at the top of the window, 
then click Extra Large 
Icons. The pictures will be 
much easier to see! 
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Renaming Pictures 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Look at the thumbnail of the picture and right click 
on it 

Click Rename on the submenu 

 

 

The original name is in BLUE. Just type over that 
name! 
 

Make sure you press Enter to keep the name! 

Since these folders (Pictures, Camera Roll and Saved Pictures) 
hold image files, you may think of them as “albums.” In Windows, 
we have the Pictures (parent) folder, with subfolders. There are 
also two permanent folders under Pictures: Camera Roll and 
Saved Pictures. Think of it this way: if you have a smart phone, 
you have a Gallery for all your photos. It’s the same for Windows 
10, but they separate the pictures you may take with a camera 
(roll) and pictures you may download from the Internet (saved). 
Together, these folders make up a gallery (Microsoft just puts them 
into the Pictures folder, so as not to confuse users with yet another 

folder named Gallery). 
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Create and Rename New Folder  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once again, you want to be able 
to view your flash drive under 
the File Explorer information 
tool. Click on Home and click 

new folder. 

 

 

Notice that the words new folder are in blue. You 
may now type in a new name for this folder.  

Press the Enter Key to make the new name of 
the folder permanent. 

Pictures 

Windows 7 was the last of the “stand alone” 
operating systems released by Microsoft. 
Originally released in July, 2009, it was an 
excellent system, but not really compatible with 
Android or Apple products (they did not “talk” to 
each other). When Windows 8 came out (August 
2012), Microsoft attempted to fix this issue by 
having users log into a Microsoft account. Having 
an account allowed users to store documents 
and pictures in the Onedrive, hence the folders 
for Camera Roll and Saved Pictures. These 
folders, seen here in Windows 10, allows users to 
log into Microsoft accounts on different devices 
and still retrieve photos. This can only happen if 
the user knows the Microsoft login information! 
(user name and password!) 

 

Once you’ve created and named the new folder, you may drag and drop the picture file into the 
folder. Place your mouse on top of the picture, click and hold your (left) mouse button, and drag 
the file onto the folder. Release the mouse button. Voilà! The picture is in the folder! 
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Copy Files from Hard Drive to Flash Drive 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Find the Sample Pictures folder on 
the hard drive 

Start in the hard drive window with the 
Sample Pictures folder. Move your 
mouse over the folder, click and hold 
the mouse button, and move the file to 
the flash drive in the navigation pane 
on the left. You will see the Copy to: 
Removable Disk tool tip on your 
screen. Let up on the mouse button. 
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Safely Remove Hardware 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Retrieve the File from the USB Drive 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Saving a Document – Save Early and Save Often! 
 
 
 
 
 
 

The easiest way to save a document is to use 
the Quick Access Toolbar 
 
Click the Save Button  
 
 (You may also click the File Tab and then click Save) 

 

Plug USB drive into proper port on computer 
 
 
 

 

 

Click “Open folders to view files” in the 
auto play dialog box 
 

Then click on Removable Drive ((labeled “Clip-It 
(F:) here)) 
 

Double click on the file name and 
the file should open in Word. 

 

These steps are extremely important. You should follow these steps each and every time you disconnect 
your flash drive from any computers! 

 

Locate the correct icon in the system tray. The system tray is in 
the lower right corner of your computer screen near the date 
and time. 
 
Click once on the icon. 

 

This submenu opens. Click once on your flash 
drive (labeled “Store n Go Clip-it” here). 

 

When the Safe To Remove 
Hardware balloon pops up, pull your 
flash drive out of the port. 
 

 

 

 

If Auto Play doesn’t pop up on the screen, 
double click “File Explorer” 
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CLOSE WORD CLOSE WORD CLOSE WORD 

 
 
 
 

If this is the first time you are saving a document, the Save As dialog box will appear on 
the screen: 
 
 

 

You need to tell the computer the following information: 
 
**Where to Save the file – be sure to choose your USB 

drive from the task pane on the left. 

File Name: remember this so 
you may find the document 
again 

 

Sometimes it is necessary to 
change the type of file. If you need 
to do this, click the upside-down 
triangle and choose another type 
(most often it will be the Word 97-

2003 Document type 

 

Location 

File Name 

Pathway (aka Address Bar) 

**If you’d like to save multiple copies of the same document, you may choose the File Tab > Save As and rename the 
document as often as you wish. You may want to save your FINAL COPY of a Word document as a PDF (Portable 
Document Format). This format is readable by any computer with a free copy of Adobe Reader. Most computers have this 
program; I consider the PDF the “safest” format for resumes. Even if a company doesn’t have your version of Word, 
they probably have Adobe Reader, so they can see your resume attachment. Last, but not least, PDFs are not changeable. 
Without the Adobe Acrobat program, no one can edit a PDF. This means that you will need to save twice for a PDF: Once 
as a Word document, and once as a PDF. 
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Create and Rename New Folder  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move File to New Folder 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Once again, you want to be able 
to view your flash drive under 
the File Explorer information 
tool. Click on Home and click 

new folder. 

 

 

Notice that the words new folder 
are in blue. You may now type in a 
new name for this folder.  

 

Press the Enter Key to make the new name of 
the folder permanent. 

 

 

Click and hold your (left) mouse button over the 
name of the file (the file name will turn blue). 

Drag your mouse over the newly created 
folder. When you’re in the correct place, you 
will see a tool tip pop up that looks like this: 
 
Let up the mouse button. 

The idea is to get to a point where you create and organize many different kinds of files on your own 
personal USB drive. For example, if I were searching for employment, I would create a resume folder 
and a cover letter folder. Then, any letters or resumes I saved could be organized within these folders: 

 

Folders Pathway 

Files 
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Resources 
**These items are available in the NIOGA Library System!** 

**Contact your local library for assistance!** 
 

Author Title 

McFedries, P Windows 11 Simplified 

McFedries, P Teach Yourself Visually: Windows 11 

Reed, J Microsoft 365 for Dummies 

Wang, W Office 2016 for Dummies 
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